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Introduction
About Configuration Manual
This configuration manual describes how to configure a Q-SHIELD Stand-alone using DeltaQC.

For more information on how to operate a Q-SHIELD Stand-alone, refer to Q-SHIELD Stand-alone Product
Instructions (printed matter 6159929570) available at https://www.desouttertools.com/resource-centre.

https://www.desouttertools.com/resource-centre
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Features
DeltaQC overview
After launching DeltaQC, the following window is displayed:

A Menu list B Toolbar
C Assembly Line area D Assembly Line details area
E Log area F Status bar
G Build area

Menu list
Item name Description
File Database: create and restore a database backup file.

Exit: exit from the DeltaQC software.
View Build area, Tree, Details, Log area, All: select/deselect the areas to show in the workspace.

Restore default layout: restore the default areas of the workspace.
Transfer PC --> Device: transfer data from the PC to the device.

Device --> PC: transfer data from the device to the PC.
Real Time Not available.
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Item name Description
Options Change language: set DeltaQC language.

Enable log file: enable/disable the log file.
List available devices: open the list of the available devices.

Service Registration: register the software.
Change license: register a new license.
For further information on how to register the software and change license, refer to DeltaQC In-
stallation and Upgrade manual.

About About...: information on the software, registration and license.

Toolbar
Icon Icon name Description

Save Save the items defined in the Assembly area.

Undo Cancel operations on items in the Assembly area.

Transfer PC --> Device Transfer data defined offline to the device connected to the PC.

Transfer Device --> PC Transfer data defined online from the device to the PC.

Controller Open information and settings of the connected device.

Bench programming This icon is not available.

Results viewer Open the Results Viewer.

Curves viewer Open the Curves Viewer.

Statistics Open the Statistics viewer.

Connect Establish connection between the device and the DeltaQC.

Disconnect Disconnect the device from the DeltaQC.

Help View the User Guides of DeltaQC products.

Assembly Line area
The Assembly Line area contains the data stored in the local database (when working in Offline mode) and the data
of the connected device (when working in Online mode).
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Assembly Line details area
The Assembly Line details area shows the details of the items selected in the Assembly Line area.

Status bar

The status bar shows:
• the connection status between the device and DeltaQC.
• the battery level of the connected device: move the cursor on the battery symbol to display the charge level in

percentage.
• information on the Pset parameters during the programming of the device with DeltaQC.

Build area
The Build area provides the commands to create and manage Psets, Tools, Routes, Transducers.

Log area
The Log viewer area displays information on the communication between the connected device and DeltaQC.
A “Log file” is automatically created in a subfolder of the installation directory of the DeltaQC (typically C:\Program
Files\Desoutter\DeltaQC\Log).

A new file is created each day the software is used; the old files can be deleted.

Search function
The DeltaQC is characterized by a search function, available to filter the various items (Psets, Tools, Routes, Trans-
ducers) displayed in the Assembly Line area.
To search items:

1. In the Assembly Line area, click on the Analog transducers/Pset/Tool/Route node.
The section Find transducers/parameter set/tool/route is displayed in the Assembly Line Details area.

2. Enter the search criteria and click on the Find button.
The results are displayed in the Assembly Line Details area.

The search function is case-sensitive and partial matching of the strings is supported. Select the Match
whole word checkbox to disable the partial matching function.

How to copy and paste a Pset/Route
1. In the Assembly Line area, expand the Pset/Route node and select the item to copy.
2. In the Management area, click on the Copy ( ) icon.
3. In the Assembly Line area, click on the Pset/Route node.
4. In the Management area click on the Paste ( ) icon.
5. In the dialog box, set the following parameters:

• Number: select the number of the Pset/Route.
By default, the Pset/Route number assigned is the first number available. It is not possible to use numbers
already assigned to other Psets/Routes.

• Name: type the name of the Pset/Route.
• Description: type additional information on the Route. This field is displayed only for Routes.
• Device type: by default, the device type is the same of the Pset/Route copied.

How to delete a Pset/Route
1. In the Assembly Line area, expand the Pset/Route node and select the item to delete.
2. In the management area, click on the Delete ( ) icon.
3. From the dialog box that opens, click on Yes to confirm.
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How to delete multiple Psets/Routes
1. In the Assembly Line area, click on the Pset/Route node.
2. In the Management area click on the Select ( ) icon.
3. In the Pset/Route selection dialog box, select the Psets/Routes to delete.

In the lower area of the dialog box, the Select all and the Unselect all buttons allow to select respectively
all the available Psets/Routes and to unselect all the Psets/Routes.

4. In the Pset/Route selection pop-up, click on the Delete ( ) icon.
5. From the dialog box that opens, click on Yes to confirm.

Working in Online mode
The DeltaQC Online mode is active when a device is connected to the PC where DeltaQC is installed.
The Online mode allows to define and transfer the test programs directly on the device, and provides shortcuts to the
device configuration, results and curves viewers.

Connecting a device for the first time
The connection between the DeltaQC and a device is done by USB cable.

1. Power ON the device and wait for it to start up.
2. Use the USB cable to connect the device to the USB port of the PC.
3. Launch DeltaQC software on the PC.
4. From the Build area, click on the Scan ( ) icon.
5. In the Select target device dialog box, click on the Scan button.
6. From the list of available devices, click on the device to connect and then on the Select button.
7.

From the DeltaQC toolbar, click on the arrow of the Connect ( ) icon and select USB to establish
connection between the device and the software.

When the device is connected to DeltaQC, the Connect ( ) icon is disabled and the Disconnect

( ) icon is enabled.

Connecting a device
1. Power ON the device and wait for it to start up.
2. Use the USB cable to connect the device to the USB port of the PC.
3. Launch DeltaQC software on the PC.
4.

From the DeltaQC toolbar, click on the arrow of the Connect ( ) icon and select USB to establish
connection between the device and the software.

When the device is connected to DeltaQC, the Connect ( ) icon is disabled and the Disconnect

( ) icon is enabled.

Creating a Pset online
1. A new Pset can be created in two ways:

• in the Build area, click on the Parameter set ( ) icon.
• in the Assembly Line area, right-click on the Pset node and then on Create a new Pset...
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2. In the dialog box, set the following parameters:
• Number: select the number of the Pset.

By default, the Pset number assigned is the first number available. It is not possible to use numbers already
assigned to other Psets.

• Name: type the name of the Pset.
• Device type: by default, the device type is the device connected to the PC.

3. Click on OK.
4. In the Assembly Line details area, select the Control strategy from the drop-down menu.
5. In the Assembly Line details area, select the Parameters tab and configure the strategy parameters.

The parameters displayed change according to the Control Strategy selected and the device version.

6. In the Assembly Line details area, select the Options tab and configure the strategy optional parameters.
7. In the lower-right corner of the Assembly Line details area, click on the Save button.

How to configure the controller parameters
The controller setup via DeltaQC can be done only in Online mode.

1.

From the DeltaQC toolbar, click on the Controller ( ) icon.
2. From the drop-down menu, click on Configuration.
3. In the General area of the Configuration dialog box, configure the available parameters and click the Save

( ) icon of each parameter.
4. In the Settings area of the Configuration dialog box, configure the available parameters and click the Save

( ) icon of each parameter.

Controller parameters

General
• Name: the name is the same displayed in the Assembly Line area. If necessary, change the name of the device in

use.
• Date and time: the date and time displayed are those of the device menu and are associated to the tightening re-

sults and curves. Select a new date and time, or click on the refresh icon to set the same date and time of the PC
connected to the device.

• Language: from the drop-down menu, select the language of the device.

Settings
• Results confirmation option: from the drop-down menu, select between:

• Never: all the results are acquired.
• Always: at the end of each test, a message asks if the result must be kept or discarded. If the result is dis-

carded, the batch count (if enabled) is not incremented.
• NOK only: at the end of each Not OK test, a message asks if the result must be kept or discarded. If the re-

sult is discarded, the batch count (if enabled) is not incremented.
• Curves confirmation option: from the drop-down menu, select between:

• Never: all the curves are acquired.
• Always: at the end of each test, a message asks if the curve must be kept or discarded.
• NOK only: at the end of each Not OK test, a message asks if the curve must be kept or discarded.

• Batch increment condition: from the drop-down menu, select between:
• OK: the batch number of a Pset is incremented only if the result is OK.
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• OK + NOK: the batch number of a Pset is always incremented, regardless of the result.
• Batches running mode: from the drop-down menu, select between:

• Reset mode: when a batch is quit, the batch count is reset. If selected, a warning message asking to confirm
the exit from the Pset is shown on the Q-SHIELD display.

• Restore mode: when a batch is quit, the batch count is not reset, and it is possible to continue the batch later.
This parameter is available only for Quality Control strategies.

• Gyroscope overspeed: from the drop-down menu, select between:
• Enable: a warning message is displayed on the device display when the maximum angular speed is exceed

during tightening operations. It is recommended to keep this parameter always enabled.
• Disable: by exceeding the maximum angular speed, no warning message is shown on the device display.

• Source type: from the drop-down menu, select between:
• Keyboard: the Pset is started by selecting it with the device keyboard.
• Tag: the Pset is started automatically after attaching the end fitting tool to the device. The Pset to execute de-

pends on the number written in the end fitting tool RFID TAG.
• Tag required: from the drop-down menu, select between:

• Enable: the Pset is started only if the end fitting tool attached to the Q-SHIELD is programmed with a tag
identifier that matches the Pset number.

• Disable: the Pset is started without the tag identifier recognition. If the Source type is set to Tag, this param-
eter is always set to Enable.

• Tag identifier: number written in the RFID TAG of the end fitting tool plugged into the Q-SHIELD. Click on the
refresh icon to update the parameter in case a new end fitting tool is plugged into the Q-SHIELD, or change the
parameter by selecting a new number from the drop-down menu. The Tag identifier numbers range from 001 to
250.

• Change screw check: from the drop-down menu, select between:
• Enable: a warning message is displayed on the Q-SHIELD display when the Change screw value is reached

during the execution of a Pset.
• Disable: by reaching the change screw value, no warning message is displayed on the Q-SHIELD display.

If Disable is selected, a warning message is shown on DeltaQC informing the operator that during the opera-
tions the screw may be damaged without getting any feedback.

• Wrench power off [minutes]: from the drop-down menu, select between:
• Disabled: when inactive, the Q-SHIELD does not power off.
• 5-10-15-30: when inactive for the selected minutes, the Q-SHIELD powers off.

The Q-SHIELD is active in the following cases:
• the operator is navigating the items of the menu;
• a Pset or a Demo mode tightening is in execution;
• the Q-SHIELD is connected to DeltaQC.

• Display switch off [minutes]: from the drop-down menu, select between:
• Disabled: when inactive, the Q-SHIELD display does not switches off.
• 5-10-15-30: when inactive for the selected minutes, the Q-SHIELD display switches off.

The Q-SHIELD is active in the following cases:
• the operator is navigating the items of the menu;
• a Pset or a Demo mode tightening is in execution.

How to transfer online data to the database
To transfer the information defined online (including test results and curves) to the local database:

1. From the DeltaQC menu list, select Transfer > Device → PC or click on the Transfer Device --> PC

( ) icon from the toolbar.
2. In the Device --> PC dialog box select the Psets tab.
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3. Select the items (Pset(s), Results and Traces) to be transferred.

Psets can be marked with different icons:
• : the Pset is already present in the database and it will overwrite the existing copy if some of its pa-

rameters have changed.
• : the Pset is not present in the database and can be added to the database.
• : the Pset cannot be transferred to the database because a Pset with the same name is already present

in the database, but it is created for another device. To transfer it, rename the Pset.
4. Click on the Save button.

How to reset the device memory
1.

From the DeltaQC toolbar, click on the Controller ( ) icon.
2. From the drop-down menu, click on Memory.

The Memory settings dialog box allows to:
• Delete all the Psets that are stored on the device memory.
• Delete all the results that are stored on the device memory.
• Delete all the diagnostics that are stored on the device memory.
• Delete all the curves that are stored on the device memory.

How to display the device information
1.

From the DeltaQC toolbar, click on the Controller ( ) icon.
2. From the drop-down menu, click on Information.

The Device information dialog box displays the following information on the connected device:
• Serial number
• Firmware version
• Type
• Battery charge level

How to display diagnostic reports
1.

From the DeltaQC toolbar, click on the Controller ( ) icon.
2. From the drop-down menu, click on Diagnostic.
3. The Diagnostic dialog box displays the last 10 diagnostic reports, click on the diagnostic ( ) icon to display the

report.

The icon is red wen at least one test gave a NOK result; the icon is green when all tests gave OK/N.A. re-
sults.

4. Use the buttons in the upper area of the report to refresh, customize, print and save the report.

Working in Offline mode
The DeltaQC Offline mode is active when no device is connected to the PC where DeltaQC is installed.
The Offline mode, allows to create all configurations in the Assembly Line area and, when the offline configuration
is done, to transfer those configurations to the device by connecting it to the PC.
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Creating a Pset offline
1. A new Pset can be created in two ways:

• in the Build area, click on the Parameter set ( ) icon.
• in the Assembly Line area, right-click on the Pset node and then on Create a new Pset...

2. In the dialog box, set the following parameters:
• Number: select the number of the Pset.

By default, the Pset number assigned is the first number available. It is not possible to use numbers already
assigned to other Psets.

• Name: type the name of the Pset.
• Device type: from the drop-down menu, select the device for which the Pset is created.

3. Click on OK.
4. In the Assembly Line details area, select the Control strategy from the drop-down menu.
5. In the Assembly Line details area, select the Parameters tab and configure the strategy parameters.

The parameters displayed change according to the Control Strategy selected.

6. In the Assembly Line details area, select the Options tab and configure the strategy optional parameters.
7. In the lower-right corner of the Assembly Line details area, click on the Save button.

Route
The Route is used to select the test programs to be transferred to the device. It is possible to create various Routes
(up to 32.000) to transfer multiple set of tests to the device.
Working offline, it is possible to create up to 32.000 test programs (Pset). The device can store up to 250 Psets.

How to create a Route

1. A new Route can be created in two ways:
• in the Build area, click on Route ( ) icon.
• in the Assembly Line area, right-click on Route and then click on Create a new Route...

2. In the dialog box, set the following parameters:
• Number: select the number of the Route.

By default, the Route number assigned is the first number available. It is not possible to use numbers al-
ready assigned to other Routes.

• Name: type the name of the Route.
• Description: type additional information on the Route.
• Device type: from the drop-down list, select the target device.

3. Click on OK.
4. The Route created is displayed in the General tab of the Assembly Line details area.
5. In the Assembly Line details area, select the Linked Pset/Tools tab to configure the Route.
6. Click on the Pset icon ( ) to add one or more Pset to the Route.
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7. The following Pset selection dialog box is displayed:

A Confirm Pset selection B Cancel Pset selection
C Clear filters D Find Pset
E Search by Pset name F Search by Pset number
G Pset check boxes

Select the check boxes next to the Pset and click on the Confirm button to add the Pset to the Route.

Use the Search bar placed in the bottom area of the dialog box to filter by name and/or number the list of
Pset displayed. The search by name is case-sensitive.

8. The selected Pset are displayed in the Linked Pset/Tools tab of the Assembly Line details area.
If necessary, select a Pset and click on the Delete ( ) icon to remove it from the Route, or use the navigation
arrows ( ) icons to change the order of the Pset in the Route.

9. In the lower-right corner of the Assembly Line details area, click on the Save button.

How to transfer a Route to the device

1. Power ON the device and wait for it to start up.
2. Use the USB cable to connect the device to the USB port of the PC.
3. From the DeltaQC menu list, select Transfer > Device → PC or click on the Transfer PC --> Device

( ) icon from the toolbar.
4. In the PC --> Device dialog box select the Route of Pset tab.
5. From the Device type drop-down menu, select the device.

The Routes created for the selected device type are displayed.
6. Select the check box of the Route to transfer.

The maximum number of routes to be selected is 1.

7. Click on the Save button to send the Route to the device.

When a Route is sent to the device, all the Psets stored in the device memory are deleted. To keep a copy
of the existing Psets stored in the device, the Psets must be saved in the database before transferring the
Route from the PC to the device (for more information, refer to How to transfer online data to the data-
base [Page 10]).

How to export Routes

1. In the Assembly Line area, click on the Route node.
2. In the Management area, click on the Export ( ) icon.
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3. In the Export - Routes selection dialog box, select the Route(s) to export.

In the lower area of the dialog box, the Select all and the Unselect all buttons allow to select respectively
all the available Routes and to unselect all the Routes.

4. In the Export - Routes selection dialog box, click on the Export ( ) button and save the Psets in the PC as an
XML file.

It is also possible to export Routes by right-clicking on the Route node in the Assembly Line area and then on
Export...

How to import Routes

The import of Routes can be done only in Offline mode. Before proceeding with the import, from the DeltaQC
toolbar click on the Disconnect icon to disconnect the Q-SHIELD from the PC.

1. In the Assembly Line area, click on the Route node.
2. In the Management area, click on the Import ( ) icon.
3. Select the XML file from the PC files.
4. In the Import – Route selection dialog box, select the Route(s) to import.

In the lower area of the dialog box, the Select all and the Unselect all buttons allow to select respectively
all the available Routes and to unselect all the Routes.

The Notes column (last column of the table) shows details about the Routes:
• If a Route is marked in green as “New”, there is no existing match in the destination database and it

possible to import the Route.
• If a Route is marked in light green as “Existent”, a Route with the same name but different configura-

tion already exists in the destination database, and the Route imported will overwrite the existing one.
• If a Route is marked in red as “Duplicated”, a Route with the same name but linked to a different de-

vice already exists in the destination database and it is not possible to import it.
5. In the Import – Route selection dialog box, click on the Import ( ) button.

It is also possible to import Routes by right-clicking on the Route node in the Assembly Line area and then on
Import...

How to create a database backup file
1. From the DeltaQC menu list, click on File > Database > Create a backup.
2. In the Database - Create a backup dialog box, click on the Folder button.
3. Select or create the destination folder and click on the OK button.
4. In the Database - Create a backup dialog box, click on the Create button.

At the end of the process, a confirmation message informs that the database backup file is created with success.

How to restore a database backup file
1. From the DeltaQC menu list, click on File > Database > Restore a backup.
2. In the Database - Restore a backup dialog box, click on the Database file  button
3. Select the database to import.
4. In the Database - Restore a backup dialog box, click on the Restore button.

If the database to restore is characterized by a version higher than the destination database, it is marked in
red and it is not possible to restore it.

Upgrade DeltaQC Software to the latest version in order to complete the operation.

If the database to restore is characterized by a version lower than the database current version, it is marked
in yellow.

Click on the Restore button and follow the procedure to perform the migration of the database and
complete the operation.

At the end of the process, a confirmation message informs that the database backup file is restored with suc-
cess.
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How to export one or more Psets
1. In the Assembly Line area, click on the Pset node.
2. In the Management area, click on the Export ( ) icon.
3. In the Export - Psets selection dialog box, select the Pset(s) to export.

In the lower area of the dialog box, the Select all and the Unselect all buttons allow to select respectively
all the available Psets and to unselect all the Psets.

4. In the Export - Psets selection dialog box, click on the Export ( ) button and save the Psets in the PC as an
XML file.

It is also possible to export Psets by right-clicking on the Pset node in the Assembly Line area and then on Ex-
port...

How to import one or more Psets
The import of Psets can be done only in Offline mode. Before proceeding with the import, from the DeltaQC
toolbar click on the Disconnect icon to disconnect the Q-SHIELD from the PC.

1. In the Assembly Line area, click on the Pset node.
2. In the Management area, click on the Import ( ) icon.
3. Select the XML file from the PC files.
4. In the Import – Pset selection dialog box, select the Pset(s) to import.

In the lower area of the dialog box, the Select all and the Unselect all buttons allow to select respectively
all the available Psets and to unselect all the Psets.

The Notes column (last column of the table) shows details about the Psets (see figure below):
• If a Pset is marked in green as “New”, there is no existing match in the destination database and it pos-

sible to import the Pset.
• If a Pset is marked in light green as “Existent”, a Pset with the same name but different configuration

already exists in the destination database, and the Pset imported will overwrite the existing one.
• If a Pset is marked in red as “Duplicated”, a Pset with the same name but linked to a different device

already exists in the destination database and it is not possible to import it.
5. In the Import – Pset selection dialog box, click on the Import ( ) button.

It is also possible to import Psets by right-clicking on the Pset node in the Assembly Line area and then on Im-
port...

Results viewer
The Results Viewer allows the user to retrieve the results from the Q-SHIELD or from the database. The Q-SHIELD
can store up to 1000 results; when the memory is full, the new results overwrite the oldest results stored.
The results can be viewed in two ways:

• Online: to view the results stored on the device by connecting the device to the DeltaQC.
• Offline: to view the results downloaded from the device and stored in the database.

How to view the results
1.

From the DeltaQC toolbar, click on the Results Viewer ( ) icon.
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2. The following Results Selection dialog box is displayed:

A Select the Device type from the drop-down
list.

When working in Online mode, the device
type is the device connected to the PC.

B Select all Psets displayed / Unselect all Psets
displayed

C Psets checkboxes D Find Pset according to: Name, Strategy, Trans-
ducer SN, date from - date to.

The search function is case-sensitive and
partial matching of the strings is sup-
ported. Select the Match whole word
checkbox to disable the partial matching
function.

E Find: click to apply the selected filters / Clear:
clear the filters applied.

Select the check boxes of the Psets and click on OK to display the results.
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3. The following results page is displayed:

A Select all the results / Unselect all the results. B From the drop-down list, select the filter to apply
to the results among: No Filter, Status OK, Status
KO, Torque status OK, Torque status KO, Angle
status OK, Angle status KO.

C Delete the selected results.

When working in Online mode, the row of
the deleted result is marked as "deleted".

D Export the selected results in an Excel file.

E Pset filter: click to open the Result Selection dia-
log box.

F Progress bar displaying the advancement of the
results downloaded.

G Number of results found. H Close the Results Viewer window.
I Click on a column headline to organize the re-

sults according to the ascending/descending or-
der of the selected column.

L Results check boxes: select/unselect results.

Curves viewer
The Curves Viewer allows the user to retrieve the curves from the Q-SHIELD or from the database. The Q-SHIELD
can store up to 25 curves (the maximum time length allowed for each curve is 30 seconds); when the memory is full,
the new curves overwrite the oldest curves stored.
The curves can be viewed in two ways:

• Online: to view the curves stored on the device by connecting the device to the DeltaQC.
• Offline: to view the curves downloaded from the device and stored in the database.

How to view curves
1.

From the DeltaQC toolbar, click on the Curves Viewer ( ) icon.
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2. The following Curve Selection dialog box is displayed:

A Select the Device type from the drop-down
list.

When working in Online mode, the device
type is the device connected to the PC.

B Psets checkbox

C Find Pset according to: Name, Strategy, date
from - date to.

The search function is case-sensitive and
partial matching of the strings is sup-
ported. Select the Match whole word
checkbox to disable the partial matching
function.

D Find: click to apply the selected filters.
Clear: clear the filters applied.

Select the check boxes of the Psets for which curves are available and click on OK to display the curves.

It is possible to select up to 25 curves.
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3. The following Curves Viewer window is displayed:

A Refresh the curves displayed when a new
curve is available.

Available only when working in Online
mode.

B Compare the available curves.

For more information, refer to How to
compare curves [Page 19].

C Curves selected in Offline mode or acquired in
Online mode.

When working in Online mode, the last
curve acquired is marked as "Curve x
LAST".

D Show cursor / Hide cursor: click to show/hide
data on the curve when moving the cursor on
the chart.

E Export the curve chart in a .jpg file. F Export the curve values in an Excel file.
G Export a report of the curve in a PDF, Excel or

Word file.
H Delete curve

Available only when working in Offline
mode.

I Close the Curves Viewer window. L Curve chart.
M Curve type / Limits / Results: select what to

view in the chart.

If the result is Not OK, it is marked on the
curve with a red X.

N General information, angle parameters and
torque parameters of the curve.

To zoom in on a specific region of the graph: position the mouse at the left edge of the area required, left-click
and move the mouse down/rightward as to draw the area to zoom, then release the mouse button.
Too navigate the zoomed in curve, right-click and move the mouse.
To zoom out: position the mouse on any area of the chart, left-click and move the mouse up/leftward, then re-
lease the mouse button.

How to compare curves
The comparison of curves allows to overlap the selected curves and compare tightening operations.

For more information on how to select curves, refer to How to view curves [Page 17].
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1. From the Curves Viewer window, click on the Compare button.
2. The following window is displayed:

A Refresh the curves displayed when a new
curve is available.

Available only when working in Online
mode.

B Curves included in the comparison.

C Curve type: from the drop-down list, select the
type of curve to display in the chart.

D Export the curves chart in a .jpg file.

E Export a report of the curves comparison in a
PDF, Excel or Word file.

F Close the Curves Viewer window.

G Curves comparison chart. H General information, angle parameters and
torque parameters of the curve: click on the +
or - to expand or collapse the nodes.

I Curves list: select/unselect the check boxes of
the curves to compare.

Statistics
The statistics can be created in two ways:

• Online: to view the statistics of the results stored on the device by connecting the device to the DeltaQC.
• Offline: to view the statistics of the results downloaded from the device and stored in the database.

How to create statistics
1.

From the DeltaQC toolbar, click on the Statistics ( ) icon.
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2. In the General tab of the Statistics page, configure the following parameters:
• Device: from the drop-down menu, select the device.

When working in Online mode, the Device type is set to the device connected to the PC.
• Measure: select between Torque or Angle.
• Test: set by default to Quality/Production.
• Check: select between Cmk/Cpk and SPC.
• Standard: from the drop-down menu, select between: ISO (3534-2:2006), CNOMO (E41.32.110N), NF (E

60-181), Normal Distribution Test (Shapiro-Wilk), Normal Distribution Test (Chi-Squared),
Q544000:1990, Q544000:2004.

• Parameters: type the expected values for Cm, Cmk, Cp, Cpk.
Only the parameters applicable to the Test and Standard selected are available.

3. Select the Results tab of the Statistics page. Then, select the following items:
• Psets: select the Pset results to use in the statistic.
• Batches: select one or more batches containing the results of the tests executed with the selected Pset.

Multiple selection is allowed only for batches with same size.
• Results: select the results to include in the statistic.

To select or unselect all the results listed, right-click on a row and click on Select all.../Unselect all...

Results with one of the following messages displayed in the Result details column, cannot be selected and
included in the statistic: Peak Not Detected, Yield Point Not Detected, Overload Detected, Rehit Detected,
Overspeed Detected, Batch Increment, Batch Decrement, Not Detected.

4. Select the Values tab of the Statistics page. The values of the selected results are displayed and by right-click-
ing on a row it is possible to copy to the clipboard the selected values.

5. Select the Statistics tab of the Statistics page. The statistics generated according to the selected standard are dis-
played:

A Statistics tab B Close the Statistics Viewer
C Statistics according to the selected standard D Remarks
E Available charts and reports

6. Click on the Graphic display / Capability chart / Histogram / Control chart buttons to display the respec-
tive charts and to save, print, or create a report of the statistics.
For more information, refer to Statistics charts and reports [Page 21].

Statistics charts and reports

Graphical display
The graphical display shows all the results versus the date of the test:
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A Display and print/export the statistics report in an
Excel, PDF or Word file.

B Save the Graphical display in a JPEG file.

C Print the Graphical display.

Capability chart
The Capability chart shows all the results in sequence:

A Display and print/export the statistics report in an
Excel, PDF or Word file.

B Save the Capability chart in a JPEG file.

C Print the Capability chart.

Histogram
The Histogram shows all the results in a histogram chart detailing how many results fall into a certain interval:



6159928680 / v.02 23 / 44

A Display and print/export the statistics report in an
Excel, PDF or Word file.

B Save the Histogram in a JPEG file.

C Print the Histogram.

Control chart
The Control chart shows the X,R charts for the statistic control tests:

A Select the statistic control rules to apply. B Remarks
C Corrective action(s). D Print the Control chart.
E Save the Control chart in a JPEG file. F Display and print/export the statistics report in an

Excel, PDF or Word file.
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References
Tightening strategies
Tightening strategies can be divided into two main categories:

• Production: strategies for tightening a screw.
• Quality Control: strategies for evaluating residual torque.

Production strategies
Production strategies can be divided into three main categories:

• Tightening within torque limits: this is the easiest tightening method, it is enough applying torque within the
limits.

Illustration 1: Torque vs. Time

A Upper torque limit B Nominal
C Lower torque limit

• Tightening within torque and angle limits: this is a more accurate way to tighten, because an additional infor-
mation (angle) is used during the tightening process.

Illustration 2: Torque vs. Angle

A Upper torque limit B Nominal
C Lower torque limit D Lower angle limit
E Upper angle limit

Using this method, it is possible to detect potential problems on the joint (refer to the following examples):
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Torque is correct, but angle is too small:
• Misalignment problem
• The hole is not completely threaded (or it is not deep

enough)
• The bolt is stopped by oil in a dead hole
• There is dirt in the threads
• The threads are damaged
• The screw is already tightened

Angle is correct, but torque is too low:
• The thread may be stripped out
• The screw is too soft (tightened over yield)
• Unexpected low µ (friction coefficient)

• Tightening with torque and additional angle rotation (torque + angle): the bolt is first tightened to a certain
torque and then it is further tightened to a specific angle. The goal is to stress the bolt over the yield point. Even
with differences in the angle, the torque (causing clamping force) is quite reliable. Sometimes the joint is spe-
cially designed and the analysis of the joint helps making sure that strain is far away from the breaking point.

Illustration 3: Torque vs. Angle

Torque Time
This strategy leads the operator in reaching the desired target torque, without any angle reading. It is enough to de-
fine the Cycle start, Minimum torque, Target torque, Maximum torque and the Change screw at parameters.
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Illustration 4: Torque vs. Time

A Change screw at B Max. torque
C Target torque D Min. torque
E Cycle start

The green area identifies the OK result area. If the torque goes over the Change screw value, a message informing
the operator to replace the screws is shown on the Q-SHIELD display.
The torque result is the maximum torque value measured during the tightening.
The Q-SHIELD display background is colored as follows:

• Blue: default color for Pset execution.
• Green: the test ends with OK result.
• Red: torque over the maximum limits.

For information on the vibration behavior, refer to Vibration parameter [Page 39].

Torque & Angle
This strategy leads the operator in reaching the desired target torque while monitoring the angle. The Angle threshold
parameter is the threshold from which to start angle measurement (normally set to 50% of the Target Torque).

Illustration 5: Torque vs. Angle

A Change screw at B Max. torque
C Target torque D Min. torque
E Angle threshold F Cycle start
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G Min. angle H Max. angle

The green area identifies the OK result area. If the torque goes over the Change screw value, a message informing
the operator to replace the screws is shown on the Q-SHIELD display.
Torque/angle results:

• If the torque/angle does not go over the torque/angle limits, the result is taken at the torque peak or angle peak as
specified in the Pset options.

• If the torque/angle goes over the limit, the result is taken as follows:

Illustration 6: Torque vs. Angle

A Max. torque B Min. torque
C Angle threshold D Cycle start
E Min. angle F Max. angle
G When the Measure peak at option is set to

Torque, and the torque (or both torque and angle)
goes over the limits, the result is taken at the
Torque peak.

H When the Measure peak at option is set to
Torque, and only the angle goes over the limits,
the result is taken at the Angle peak.

Illustration 7: Torque vs. Angle

A Max. torque B Min. torque
C Angle threshold D Cycle start
E Min. angle F Max. angle
G When the Measure peak at option is set to An-

gle, and the angle (or both torque and angle) go
over the limits, the result is taken at the Angle
peak.

H When the Measure peak at option is set to An-
gle, and only the torque goes over the limits, the
result is taken at the Torque peak.
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The Q-SHIELD display background is colored as follows:
• Blue: default color for Pset execution.
• Green: the test ends with OK result.
• Red: torque and/or angle over the maximum limits.

For information on the vibration behavior, refer to Vibration parameter [Page 39].

Torque + Angle
This strategy guides to operator in reaching the desired target angle while monitoring the torque. The Angle thresh-
old parameter is the threshold from which to start angle measurement (normally set to 50% of the Target Angle).

Illustration 8: Torque vs. Angle

A Change screw at B Max. torque
C Target torque D Min. torque
E Angle threshold F Cycle start
G Min. angle H Target angle
I Max. angle

This strategy is similar to Torque & Angle; the Target Angle value is required instead of the Target Torque, and the
progressive bar increases with the angle and not with the torque.
Torque/angle results:

• If the torque/angle does not go over the torque/angle limits, the result is taken at the torque peak or angle peak as
specified in the Pset options.

• If the torque/angle goes over the limit, the result is taken as follow:

Illustration 9: Torque vs. Angle
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A Max. torque B Min. torque
C Angle threshold D Cycle start
E Min. angle F Max. angle
G When the Measure peak at option is set to

Torque, and the torque (or both torque and angle)
goes over the limits, the result is taken at the
Torque peak.

H When the Measure peak at option is set to
Torque, and only the angle goes over the limits,
the result is taken at the Angle peak.

Illustration 10: Torque vs. Angle

A Max. torque B Min. torque
C Angle threshold D Cycle start
E Min. angle F Max. angle
G When the Measure peak at option is set to An-

gle, and the angle (or both torque and angle) go
over the limits, the result is taken at the Angle
peak.

H When the Measure peak at option is set to An-
gle, and only the torque goes over the limits, the
result is taken at the Torque peak.

The Q-SHIELD display background is colored as follows:
• Blue: default color for Pset execution.
• Green: the test ends with OK result.
• Red: torque and/or angle over the maximum limits.

For information on the vibration behavior, refer to Vibration parameter [Page 39].

Prevailing Torque Automatic Compensation
The purpose of the strategy is to reach the desired Target torque and to verify whether torque values result within
configured limits during a pre-established angle interval.

Illustration 11: Torque vs. Angle

A Final Max. torque B Final Target torque
C Final Min. torque D Prevailing Max. torque
E Prevailing Min. torque F Prevailing Min. angle
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G Prevailing Max. angle H Final Min. angle
I Final Max. angle L Drag torque
M Torque Peak +/- Drag torque

This strategy execution consists in two stages:

1. Prevailing phase: once the cycle start and the angle threshold are exceeded, the first stage of the strategy begins
and the values of the measured torque and angle peak appears on the display. The first progress bar indicates
the approach to the Prevailing max angle. The minimum, maximum or average torque calculated during this
phase is called Drag torque and will be used in the next phase.
Drag Torque results:

• Once the Prevailing max angle is reached, if the Drag torque does not exceed the prevailing torque limits
the strategy will continue in the second phase.

• If the Drag torque goes over the configured prevailing limits, this first step fails and the strategy will end
with a NOK result.

The Q-SHIELD display background is colored as follows:
• Blue: default color for Pset execution.
• Green: the test ends with OK result.
• Red: torque and/or angle over the maximum limits.

2. Torque and Angle phase: the second stage of the strategy behaves like a Torque & Angle strategy, where the
Target torque must be reached within a specific angle interval. The displayed torque is the torque peak +/- Drag
torque, depending on the compensation option selected in the Pset. The second progress bar indicates the ap-
proach to the Final Target Torque. The torque values stored for the trace are the actual torque values, without
considering the value of the Drag Torque.
Results:

• If the Final target torque (torque peak +/- Drag torque) does not exceed the limits during the specified an-
gle interval, the result is OK.

• If the Final target torque (torque peak +/- Drag torque) goes over the limits during the specified angle inter-
val, the second phase of the strategy ends with a NOK result.

The Q-SHIELD display background is colored as follows:
• Blue: default color for Pset execution.
• Green: the test ends with OK result.
• Red: torque and/or angle over the maximum limits.

For information on the vibration behavior, refer to Vibration parameter [Page 39].

Quality control strategies
Quality control strategies can be divided into two main categories:

• Residual check angle: it measures the torque necessary to rotate the screw further, measuring it at the specified
angle.

• Peak torque: it measures the peak of the torque necessary to rotate the screw further; the operator must stop as
soon as the screw starts rotating.

Residual Torque/Angle Automatic
This strategy evaluates the residual torque on a joint, measuring the torque necessary to rotate the screw further.

Illustration 12: Torque vs. Angle

A Change screw at B Max. torque
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C Min. torque D Angle threshold
E Cycle start F Breakaway point
G Residual torque H Breakaway point
I Residual torque

CASE A (chart on the left): Normally there is a rapid change of the gradient of the torque/angle function when the
bolt starts moving.
CASE B (chart on the right): Sometimes, due to high static friction built into the joint (for instance, for no lubrica-
tion, conical seat) as soon as the bolt moves the torque decreases, and the real residual torque is lower than the peak
torque necessary to overcome the static friction.

In both the above cases, the algorithm detects automatically the correct breakaway point.

Min. torque and Max. torque define the torque limits where the result is considered as OK. The Angle threshold, that
must be greater than the Cycle start, defines the point from which the Q-SHIELD starts measuring the angle.
If during the residual torque check the operator goes over the Change Screw value, a message is shown on the Q-
SHIELD display to indicate that the screw must be replaced with a new one.
Torque results:

• If the breakaway point is detected, the result is the Residual torque.
• If the breakaway point is not detected (or if the torque goes over the Change Screw value) the result is the Max.

torque measured.
The Q-SHIELD display background is colored as follows:

• Blue: default color for Pset execution.
• Green: the residual torque measured is between the minimum and maximum torque.
• Red: the residual torque is either below the minimum or over the maximum torque, or the residual torque point is

not detected.
For information on the vibration behavior, refer to Vibration parameter [Page 39].

Residual Torque/Angle
This strategy evaluates the residual torque on a joint, measuring the torque necessary to rotate the screw further.

Illustration 13: Torque vs. Angle

A Change screw at B Max. torque
C Min. torque D Angle threshold
E Cycle start F Target angle
G Residual torque

Min. torque and Max. torque define the torque limits where the result is considered as OK. The Angle threshold, that
must be greater than the Cycle start, defines the point from which the Q-SHIELD starts measuring the angle. 
The recommended values are Target Angle set to 2 degrees and the Angle Threshold set to the 50% of the expected
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residual torque.
If during the residual torque check the operator goes over the Change Screw value, a message is shown on the Q-
SHIELD display to indicate that the screw must be replaced with a new one.
Torque result:

• If the target angle is reached, the result id the torque measured at the target angle,
• If the target angle is not reached (or if the torque goes over the Change Screw value), the result is the Max.

torque measured.
The Q-SHIELD display background is colored as follows:

• Blue: default color for Pset execution.
• Green: the residual torque measured is between the minimum and maximum torque.
• Red: the residual torque is either below the minimum or over the maximum torque, or the residual torque point is

not detected.
For information on the vibration behavior, refer to Vibration parameter [Page 39].

Residual Peak/Torque
This strategy evaluates the residual torque on a joint as the peak of the torque necessary to rotate the screw further.

Illustration 14: Torque vs. Angle

A Change screw at B Max. torque
C Min. torque D Cycle start
E Torque peak

The result of this strategy is affected by the operator movement; it is important to release the torque as soon as
the screw starts moving.

The Q-SHIELD display background is colored as follows:
• Blue: default color for Pset execution.
• Green: the torque peak is between the minimum and maximum torque.
• Red: the torque peak is below the minimum or over the maximum torque.

Drag Torque
The purpose of the present strategy is to verify that the value of the Drag torque type (Minimum, Maximum or Aver-
age) results within configured torque limits during a pre-established angle interval.
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Illustration 15: Torque vs. Angle

A Change screw at B Max. torque
C Min. torque D Angle threshold
E Cycle start F Start angle
G Stop angle H Drag torque

Torque/Angle results:
• If the value of the chosen Drag torque type (Minimum, Maximum or Average) falls within the established torque

and angle interval, the result is OK.
• If the value of the chosen Drag torque type (Minimum, Maximum or Average) does not fall within the estab-

lished torque and angle interval, the result is NOK.
The Q-SHIELD display background is colored as follows:

• Blue: default color for Pset execution.
• Green: the Drag torque (Minimum, Maximum or Average) at the Stop angle is between the minimum and maxi-

mum torque.
• Red: torque result is below the minimum or over the maximum torque.

For information on the vibration behavior, refer to Vibration parameter [Page 39].
Algorithm used to detect the yield point:
The torque/angle trace is sampled at 1 kHz. Several Torque and angle values Ti and Ai are calculated as moving av-
erages of 128 torque/angle samples measured by the Q-SHIELD. This means that for each next value acquired, new
Ti and Ai values are calculated: 
10 Ti and Ai values are considered step by step to calculate the following parameters:

• Sum of the torque values
• Sum of the angle values
• Sum of torque values multiplied by angle values
• Sum of the square of the angle values

From these terms calculated above, linear regression is applied to obtain the gradient of the torque/angle trace: 
The gradient αt is recalculated by linear regression each next sample acquired, and the average of 20 different values
αt is calculated.
This average is also recalculated sample by sample. If 30 consecutive values of this αaverage (absolute value) are not
greater than a threshold value of the Linear slope Coefficient (LSC) multiplied by 0.4, and for 2 degrees they stay un-
der the Linear slope Coefficient multiplied by 1.6, the yield point is considered to have been detected.

Yield Point
The purpose of the strategy is to detect the Yield point of the joint under analysis that is the bolt elastic limit (yield).
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Illustration 16: Torque vs. Angle

A Change screw at B Max. torque
C Min. torque D Angle threshold
E Cycle start F Yield point

It is recommended to reach the Yield Point with a single tightening; ratcheting is allowed if it is done at the 50 ÷
60 % (MAXIMUM) of the supposed Yield Point.

In order to investigate the elastic characteristic of the bolt the Pset should be configured in this way:
The Cycle start must be set at least to 10% of the supposed Yield point.
The Angle threshold, that must be greater than the Cycle start, defines the point from which the Q-SHIELD starts
measuring the angle.
The Min torque and the Max torque define the torque limits within which the value of the Yield point detected will
be considered as OK.
Furthermore is necessary to set an appropriated coefficient, the Linear Slope Coefficient (LSC). This parameter is ac-
tive only for the Yield Point strategy, and characterizes the joint stiffness in the linear part of the curve, as torque/an-
gle slope in the Nm/° measurement unit. In other terms, the LSC is the slope of the torque/angle characteristic of the
joint in the first part (linear). The minimum value is 0.1, which suits also very soft joints with a ration smaller than
0.1. The default value is 0.5. The Linear slope coefficient may be calculated experimentally for each single joint
(only after executing a trial test to get data for calculating it) as follows:

Illustration 17: Torque vs. Angle

 = Linear slope coefficient
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If the unit of measurement used is different from Nm, the Linear slope Coefficient must be converted to Nm/°.
For instance, for a joint with a stiffness of 0.6 lbf*ft/°, since 1 lbf*ft = 1.3558 Nm, the Linear Slope Coefficient
must be converted to:

0.6 lbf*ft/° → 0.6x1.3558 = 0.81 Nm/°
With this strategy, the wrench detects the yield point automatically and, depending on the specified torque limits
range, the Torque result may be one of the following options:

• If the Yield Point is detected (within torque limits), the result is taken at the Yield Point.
• If the Yield Point is not detected, the result is the torque peak.
• If the torque goes over the Change Screw value, the Yield Point is no longer detected and the torque result is the

torque peak.
The Q-SHIELD display background is colored as follows:

• Blue: default color for Pset execution.
• Green: the Yield point is detected within torque limits.
• Red: the Yield point is below or above the torque limits or not detected.

For information on the vibration behavior, refer to Vibration parameter [Page 39].
The Algorithm used to detect the yield point is the following: 
The torque/angle trace is sampled at 1 kHz. 
Several torque and angle values Ti and Ai are calculated as moving averages of 128 torque/angle samples measured
by the wrench. This means that for each next value acquired, new Ti and Ai values are calculated: 
10 Ti and Ai values are considered step by step to calculate the following parameters:

• Sum of the torque values
• Sum of the angle values
• Sum of torque values multiplied by angle values
• Sum of the square of the angle values

From these terms calculated above, linear regression is applied to obtain the gradient of the torque/angle trace: 
The gradient αt is recalculated by linear regression each next sample acquired, and the average of 20 different values
αt is calculated. 
This average is also recalculated sample by sample. If 30 consecutive values of this αaverage (absolute value) are not
greater than a threshold value of the Linear slope Coefficient (LSC) multiplied by 0.4, and for 2 degrees they stay un-
der the Linear slope Coefficient multiplied by 1.6, the yield point is considered to have been detected.

Residual Loose and Tighten
The purpose of this strategy is to loosen the bolt up to a target angle, and to tighten it back to the original Zero posi-
tion.
In the first stage of the strategy, the operator unscrews the bolt for a few degrees; in the second stage of the strategy,
the operator screws the bolt back to the starting position.

Loosening phase Tightening phase

Torque vs. Angle
A: Target angle

Torque vs. Angle
B: Zero position

Set the Target Angle to a few degrees, so that the torque during the loosening phase does not fall under the Cy-
cle start value.

The residual torque result is the torque at the end of the tightening operation (measured when the original Zero posi-
tion is reached back).
Results:
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• If the original Zero position is reached within 30s and within the torque limits, the result of the test is OK; the
torque result is the torque measured at the Zero position and the angle result is equal to zero.

• If the Zero position is not reached within 30s, the result of the test is NOK; the angle result is negative and the
torque result is the last torque value measured.

• If the Zero position is reached within torque limits, but the Peak torque is over the Change screw value, the result
is NOK.

During the loosening phase of the strategy, the Q-SHIELD display background is colored as follows:
• Blue: default color for Pset execution.
• Green: the Target angle of the loosening process is reached (when the tightening phase starts, the green led

switches off).
• Red: the Target angle is not reached, or reached but 30s timeout expire; the tightening operation starts before the

Target angle is reached.
During the re-tightening phase of the strategy, the Q-SHIELD display background is colored as follows:

• Blue: default color for Pset execution.
• Green: the Loose and Tighten process is successfully completed within Torque limits.
• Red: the loosening and tightening process is completed but the torque result is below or above the torque limit,

or over the Change screw value; the re-tightening operation started before the Target angle was reached; the 30s
timeout expires.

For information on the vibration behavior, refer to Vibration parameter [Page 39].

Minimum after breakaway
The Minimum after breakaway strategy is ideal to find the residual torque in curves with not coinciding breakaway
and residual points. 
The strategy aims to search a local minimum within the angle interval set by the user (Residual angle threshold 1 and
Residual angle threshold 2). 
When the Residual angle threshold 2 is surpassed, the measuring interval is over and if a candidate residual point was
found, it is chosen as result. 
Otherwise, the maximum torque measured during the cycle will be shown on the display, and the result will be Not
detected. 
For a proper residual detection, make sure that the breakaway and residual points are included in the angle interval
(Residual angle threshold 1 and Residual angle threshold 2), and that the Residual angle threshold 2 is reached and
surpassed during the check.

Residual intersection
The Residual intersection strategy is ideal to find the residual torque in curves with coinciding breakaway and resid-
ual points.
How the strategy works: 
During the check the intersection points of the curve with Residual angle threshold 1, 2, 3, and 4 are stored. 
When the angle level surpasses Residual angle threshold 4, the operator is warned that the tightening can stop. 
The four points torque and angle values are used as coordinates to find two lines passing through them (the first two
points identify the first line, the third and fourth points the second one). The intersection of the two lines is consid-
ered the residual point.

Slope change
The slope change strategy can find the residual torque in either curves with coinciding breakaway and residual points
or with not coinciding ones.
The result is obtained after a post-processing applied to acquired data, which are examined backward starting from
the Residual angle threshold 2.
The Residual point is found when the ratio of the gradients (the one in Residual angle threshold 2 being the refer-
ence) is greater than a set threshold (Slope change).
Given the multiplicative relation between the two gradients, if the reference gradient is too flat the residual point
might be not properly detectable.
VARIANT A: The result is expected to be OK before the Residual angle threshold 1.
VARIANT B: The result is expected to be OK within Residual angle threshold 1 and Residual angle threshold 2.
How the gradient change strategy works? 
We have defined the Slope change coefficient as the ratio of the gradients: Slope Change = mresult/mref. 
Setting Slope change=1, we can get a result nearer to the reference (Residual angle threshold 2). 
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By increasing the value of the slope change, the algorithm will get a result farther from the reference (Residual angle
threshold 2), where the ratio between the gradient of the result point and the gradient of the reference is higher (>
Slope change).
In case of curves with different Breakaway and Residual points, if the algorithm doesn’t find between Residual angle
threshold and the local minimum a slope ratio surpassing the slope change set, then the result is always taken at the
local minimum.

Pset parameters
Torque parameters
Parameter Description
Cycle Start Torque value from which the tightening operation starts.

This value must be higher than the min. load value of the transducer; if it is not, when
the Pset starts, a “Min load error” message is shown on the display.

Angle threshold For strategies that include the angle measurement, this parameter specifies the torque
value from which the measurement of the angle starts.

Min torque Lower torque limit.
Target torque Torque value set as tightening goal.

Valid only for the strategies “Production: Torque Time” and “Production: Torque &
Angle”.

Max torque Higher torque limit.
Torque correction coefficient For normal operations, this parameter is set to 1 (default value for Torque correction

coefficient). If an extension is used, this coefficient allows to compensate the effect of
the extension on the torque measurement.
For further information, refer to How to calculate the Torque Correction Coefficient
[Page 42].

Change screw at If the torque reaches this limit, the message “Change screw” is shown on the display.
This parameter must be set higher than the Max torque value.

Unit of measurement Select the desired unit.
Drag Torque type (Min, Max and
Average)

It is the torque value resulting from the measurements taken within a pre-established
angle interval. Select Min, Max or Average to calculate the Drag torque value.
Valid only for the strategies “Production: Prevailing Torque – Automatic compensa-
tion” and “Quality: Drag torque”.

Prevailing min torque It is the Drag torque lower limit of the first stage of the strategy. Valid only for the
strategy “Production: Prevailing Torque – Automatic compensation”.

Prevailing max torque It is the Drag torque upper limit of the first stage of the strategy. Valid only for the
strategy “Production: Prevailing Torque – Automatic compensation”.

Drag torque compensation This option permits to add or subtract the Drag torque to the torque peak in the second
stage of the strategy.
Valid only for the strategy “Production: Prevailing Torque – Automatic compensa-
tion”.

Final min torque It is the lower limit of the Final target torque during the second stage of the strategy.
Valid only for the strategy “Production: Prevailing Torque – Automatic compensa-
tion”.

Final target torque It is the torque result of the tightening, considering the Drag Torque value.
Valid only for the strategy “Production: Prevailing Torque – Automatic compensa-
tion”.

Final max torque It is the upper limit of the Final target torque during the second stage of the strategy.
Valid only for the strategy “Production: Prevailing Torque – Automatic compensa-
tion”.
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Parameter Description
Linear slope coefficient This parameter characterizes the joint stiffness in the linear part of the curve, as

torque/angle slope. The minimum value of the Linear slope coefficient is 0.1; it suits
also very soft joints with a ration less than 0.1. The default value is 0.5.
Valid only for the strategy “Quality: Yield Point”.

If the unit of measurement used is different from Nm, the Linear slope coefficient
is automatically converted according to the unit of measurement selected.

If the Q-SHIELD is connected while programming, the following torque parameters are set by default as follows:
• Cycle start = Angle threshold = Minimum torque = Maximum torque = 1% transducer nominal torque.
• Change screw at = Transducer nominal torque.
• Target torque (if available in the selected control strategy) = Transducer nominal torque (in this case also the

Max torque is set to this value).

All the Torque parameters defined for a Pset must be higher than the minimum load and lower than the capacity
of the Q-SHIELD; otherwise, a Min Load error or a Capacity Error will be shown on the display when the Pset
starts. Furthermore, the set of parameters must be reliable. For example, when storing a Pset, if the Min Torque
is greater than the Target Torque, an error message is shown.

Angle parameters
Parameter Description
Min angle Lower angle limit.
Max angle Higher angle limit.
Target angle It is the angle value at which the residual torque is measured.

Valid only for the strategies “Production: Torque + Angle” and “Quality: Residual
Torque/Angle”.

Angle correction coefficient For normal operations, this parameter is set to 0 (default value for Angle correction
coefficient). If an extension is used, this coefficient allows to compensate the error in
the angle reading due to the bending of the extension.
For further information, refer to How to calculate Angle Correction Coefficients
[Page 43].

Prevailing min angle It is the lower limit of the angle interval during which torque values have to be
checked in the first stage of the strategy.
Valid only for the strategy “Production: Prevailing Torque – Automatic compensa-
tion”.

Prevailing max angle It is the upper limit of the angle interval, during which torque values have to be
checked in the first stage of the strategy.
Valid only for the strategy “Production: Prevailing Torque – Automatic compensa-
tion”.

Final min angle Valid only for the strategy “Production: Prevailing Torque – Automatic compensa-
tion”; it is the lower limit of the angle interval, during which the final torque value has
to be checked.

Final max angle It is the upper limit of the angle interval, during which the final torque value has to be
checked.
Valid only for the strategy “Production: Prevailing Torque – Automatic compensa-
tion”.

Start angle It is the lower limit of the angle interval within which the torque value has to be
checked.
Valid only for the strategy “Quality: Drag torque”.

Stop angle It is the upper limit of the angle interval within which the torque value has to be
checked.
Valid only for the strategy “Quality: Drag torque”.
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Vibration parameter
Parameter Description
Vibration start (% / Nm / Deg) It is possible to set Vibration start as a value expressed in percentage, torque, or angle.

Vibration start (% / Nm / Deg) parameter is available for the following control strate-
gies: “Production: Torque Time”, “Production: Torque & Angle”, “Production:
Torque + Angle”, “Production: Prevailing Torque – Automatic compensation”, “Qual-
ity: Residual Torque/Angle”, and “Quality: Drag Torque”.
Set Vibration start (% / Nm / Deg) parameter in one of the following conditions:

• when creating a new Pset
• when, for a pre-existing Pset, it is necessary to change the control strategy

By default, Vibration start (%) parameter is equal to 95%. It can range from 1 to
100%.

• In case of Production: Torque Time control strategy, set Vibration start (%) or Vibration start (Nm) parameter.
The Q-SHIELD starts vibrating after getting the percentage or torque related to the “vibrating target torque”. 
If Vibration start (%) is selected, below is an example to calculate the “vibrating target torque”: 
If: 
Cycle start = 2 Nm Target torque = 12 Nm 
Vibration start = 50% 
Then: 
“Useful torque interval” = (Target torque – Cycle start) × Vibration start = (12 – 2) Nm × 50%= 5 Nm 
Finally: 
Vibrating target torque = “Useful torque interval” + Cycle start = (5 + 2) Nm = 7 Nm 
During the test, if the tightening is within the limits (Max Torque and Min Torque) the vibration is continuous. If
the tightening is out of the limits (Max Torque and Min Torque), the vibration is alternate.
At the end of the test, if the tightening is OK, the Q-SHIELD vibrates for three times at a specified interval (1
second). If the tightening is NOK, the Q-SHIELD vibrates at specified intervals continuously; stop the vibration
with one of the following procedures:

• do a new tightening;
• press OK → the Q-SHIELD is ready for a new measurement;
• press CL → the Q-SHIELD exits from the Pset.

• In case of Production: Torque & Angle control strategy, set Vibration start (%) or Vibration start (Nm). The Q-
SHIELD starts vibrating after getting the percentage or torque related to the “vibrating target torque”. 
If Vibration start (%) is selected, below is an example to calculate the “vibrating target torque”: 
If: 
Cycle start = 2 Nm Target torque = 12 Nm 
Vibration start = 50% 
Then: 
“Useful torque interval” = (Target torque – Cycle start) × Vibration start = (12 – 2) Nm × 50%= 5 Nm 
Finally: 
Vibrating target torque = “Useful torque interval” + Cycle start = (5 + 2) Nm = 7 Nm 
During the test, if the tightening is within the limits (Max/Min Torque and Max/Min Angle) the vibration is con-
tinuous. If the tightening is out of the limits (Max/Min Torque and Max/Min Angle), the vibration is alternate. 
At the end of the test, if the tightening is OK, the Q-SHIELD vibrates for three times at a specified interval (1
second). If the tightening is NOK, the Q-SHIELD vibrates at specified intervals continuously; stop the vibration
with one of the following procedures:

• do a new tightening;
• press OK → the Q-SHIELD is ready for a new measurement;
• press CL → the Q-SHIELD exits from the Pset.

• In case of Production: Torque + Angle control strategy, set Vibration start (%) or Vibration start (Deg). The Q-
SHIELD starts vibrating after getting the percentage or angle related to the “target angle”. 
During the test, if the tightening is within the limits (Max/Min Torque and Max/Min Angle) the vibration is con-
tinuous. If the tightening is out of the limits (Max/Min Torque and Max/Min Angle), the vibration is alternate. 
At the end of the test, if the tightening is OK, the Q-SHIELD vibrates for three times at a specified interval (1
second). If the tightening is NOK, the Q-SHIELD vibrates at specified intervals continuously; stop the vibration
with one of the following procedures:
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• do a new tightening;
• press OK → the Q-SHIELD is ready for a new measurement;
• press CL → the Q-SHIELD exits from the Pset.

• In case of Production: Prevailing Torque – Automatic compensation control strategy, set Vibration start (%)
or Vibration start (Nm). The Q-SHIELD starts vibrating after getting the percentage or torque related to the “tar-
get torque”.
During the test, if the tightening is within the limits the vibration is continuous. If the tightening is out of the lim-
its, the vibration is alternate.
At the end of the test, if the tightening is OK, the Q-SHIELD vibrates for three times at a specified interval (1
second). If the tightening is NOK, the Q-SHIELD vibrates at specified intervals continuously; stop the vibration
with one of the following procedures:

• do a new tightening;
• press OK → the Q-SHIELD is ready for a new measurement;
• press CL → the Q-SHIELD exits from the Pset.

• In case of Quality: Residual Torque/Angle and Quality: Drag Torque control strategies, set Vibration start
(%) or Vibration start (Deg). The Q-SHIELD starts vibrating after getting the percentage or angle related to the
Target angle or Stop angle respectively.
During the test, if the tightening is within the limits (Max Torque and Min Torque) the vibration is continuous. If
the tightening is out of the limits (Max Torque and Min Torque), the vibration is alternate.
At the end of the test, if the tightening is OK, the Q-SHIELD vibrates for three times at a specified interval (1
second). If the tightening is NOK, the Q-SHIELD vibrates at specified intervals continuously; stop the vibration
with one of the following procedures:

• do a new tightening;
• press OK → the Q-SHIELD is ready for a new measurement;
• press CL → the Q-SHIELD exits from the Pset.

• In case of Quality: Residual Torque/Angle Automatic, Quality: Residual Peak/Torque and Quality: Yield
Point control strategies, the Q-SHIELD starts vibrating after getting the half of the torque limits: (Max Torque +
Min Torque) / 2.
During the test, if the tightening is over the Max Torque, the vibration is alternate.
At the end of the test, if the tightening is OK, the Q-SHIELD vibrates for three times at a specified interval (1
second). If the tightening is NOK, the Q-SHIELD vibrates at specified intervals continuously; stop the vibration
with one of the following procedures:

• do a new tightening;
• press OK → the Q-SHIELD is ready for a new measurement;
• press CL → the Q-SHIELD exits from the Pset.

• In case of Quality: Residual Loose and Tighten control strategy, the Q-SHIELD vibrates for 2 seconds when
the loosening phase is completed, and at the end of the test when the Zero position is reached.
During the test, if the tightening is over the Max Torque, the vibration is alternate.
At the end of the test, if the tightening is OK, the Q-SHIELD vibrates for three times at a specified interval (1
second). If the tightening is NOK, the Q-SHIELD vibrates at specified intervals continuously; stop the vibration
with one of the following procedures:

• do a new tightening;
• press OK → the Q-SHIELD is ready for a new measurement;
• press CL → the Q-SHIELD exits from the Pset.

Time parameters
Paramter Description
End cycle time This parameter is applied when the torque goes below the cycle start after the target

torque value is reached; the default value is 0.1 second.
Minimum value: 0.1 seconds
Maximum value: 5 seconds

This parameter is not used for residual torque strategies.
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Paramter Description
Abort cycle time This parameter is applied when the torque goes down the cycle start but has not

reached the target torque value yet. This allows the operator to release the torque for a
while and recharge during the tightening operation; the default value is 5 seconds.
Minimum value: 0.1 seconds
Maximum value: 30 seconds

The Q-SHIELD ends the tightening operation if the torque drops below the Cycle Start value for a longer time than
the timer.

Illustration 18: Torque vs. Time

A Target torque B Cycle start
C Abort cycle time D End cycle time

Before the torque reaches the Target Torque, the Abort Cycle Time is applied.
After the torque reaches the Target Torque, the End Cycle Time is applied.
The test ends when the torque remains below the Cycle Start value for more time than the timeout.

For Residual torque strategies, the Abort Cycle Time is the only timeout available in the test strategy; for Resid-
ual Torque/Angle and Residual Torque/Angle Automatic, when the residual torque is detected the test ends even
if the timeout has not expired.

Batch parameters
Name Description
Batch count Select the check box to run the Pset more than one time.
Batch size If Batch count is enabled, it specifies how many times the Pset must be executed.

Maximum value: 99

If the Batch count is disabled, the Batch status in the tightening results is always
OK. By enabling the Batch count and setting the Batch size to 1, the Batch result
is OK only if the Pset result is OK. If the Batch size is greater than 1, the Batch
result is OK only if all the Pset results are OK.

Options parameters
Name Description
Direction Select the tightening direction of the test between clockwise (CW) and counterclock-

wise (CCW).
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Name Description
Measure Peak at Select between Torque and Angle.

A: Torque; B: Torque at torque peak; C: Torque at angle peak; D: Angle

The torque result of a tightening changes according to the tightening strategy.

Check RE-HIT If the operator tightens a screw that is already tightened, the torque increases with just
a little rotation (or without any rotation) of the screw. This function monitors this
event and shows an error message on the display.
Select the check box to enable this function, and specify the Check RE-HIT value,
that is typically set to few degrees.
If the torque reaches the Min. Torque value within this angle, the error message “RE-
HIT” is shown on the Q-SHIELD display.

The Check RE-HIT option is available only for Production control strategies.

Correction Coefficients for extensions
When the joint design or space limitations preclude the use of standard sockets / tools, it may be necessary to use
special extension spanners to fit the application. In these cases, the Q-SHIELD measurements must be adequately
compensated since the factory calibration is made for the standard arm, and the extension arm (E) increases the
torque measured. The angle measured is also affected by the extensions, due to its specific torsion when torque is ap-
plied.

How to calculate the Torque Correction Coefficient

D Torque value displayed T Applied torque
L Standard arm (from the center of the handle to the

center of the end fitting tool
L+E Total arm

E Extension arm

From the relation between the displayed and applied torque , the torque correction coefficient is given by the
following formula:

Torque correction coefficient = 
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How to calculate Angle Correction Coefficients
When an extension is used, the angle correction coefficient allows linear compensation of extension torsion due to
the torque applied. The value is expressed in degrees at the device capacity.
To calculate the proper angle correction coefficient, the torque coefficient of the extension must be already calcu-
lated (refer to How to calculate the Torque Correction Coefficient [Page 42]) and specified in the Pset used for cal-
culating the angle correction coefficient.

1. Create a Pset with the following parameters:
• Control strategy: Torque & Angle
• Torque correction coefficient: 1
• Target torque: 80% of the device capacity
• Cycle start and Angle threshold: 10% of the Q-SHIELD capacity
• Minimum angle: 0
• Target angle: 15
• Maximum angle: 30
• Check RE-HIT: Disabled

2. Start the Pset.
3. Apply the target torque specified in the Pset, operating the device on a vise (or on static transducer).

Since for this test the Torque Correction Coefficient is set to 1, the torque applied to the vise is higher than
the torque shown on the display. The vise must support at least the maximum torque of the Pset multiplied
by the Torque Correction Coefficient calculated above.

4. The angle displayed is the bending of the extension applied to the torque shown on the display. Therefore, the
Angle Correction Coefficient is equal to the following formula:
Angle Correction Coefficient = Q-SHIELD Capacity / (Torque measured - Angle threshold) x Angle
measured

The Q-SHIELD Capacity is the Max torque value shown in DeltaQC in the information of the Transduc-
ers > Connected transducer.

After storing the Angle Correction Coefficient, it is NOT possible to use the Demo mode to verify the cor-
rect operation of the angle coefficient, since the Demo mode does not consider the correction coefficients.
Therefore, for a verification test, a Pset must be used.

Correction formulas
During the tightening, the torque and angle measured by the transducers are corrected to obtain the real torque and
angle values that are displayed on the Q-SHIELD and used in the tightening curves and results. The correction for-
mulas are as follows:
Torque displayed = Torque measured x Torque Correction Coefficient
Angle displayed = Angle measured - Angle Correction Coefficient x [(Torque displayed - Angle threshold) /
(Q-SHIELD Capacity - Torque Correction Coefficient)]

The Q-SHIELD Capacity is the Max torque value shown in DeltaQC in the information of the Transducers >
Connected transducer.
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